Chapter 11 - Multimedia
Faster hardware, new input devices, and high-speed access to the World Wide Web have created a new generation of multimedia content and applications throughout the corporate world. Microsoft® Windows® 2000 Professional makes it easier for corporate managers and network administrators to use multimedia.
In This Chapter
Quick Guide to Multimedia    
What’s New    
Optimizing Workstations for Multimedia    
Using Multimedia Effectively    
Troubleshooting Multimedia    
Related Information in the Resource Kit

For more information about telephony, videophones, or multimedia conferencing, see “Telephony and Conferencing” in this book.

For more information about digital video cameras, see “Scanners and Cameras” in this book.

For more information about support for Human Interface Devices (HIDs), IEEE 1394, multiple monitor support, and the Universal Serial Bus (USB), see “Hardware Support” in this book.

For more information about deploying custom configurations using group and local policies, see “Introduction to Configuration and Management” in this book.
Quick Guide to Multimedia
Use this guide to quickly find the information you need about using multimedia in Windows 2000 Professional.
Review the new features and devices supported in Windows 2000.
Windows 2000 combines the best of Windows 98 multimedia features with the power of Windows NT 4.0.

See “What’s New” in this chapter.
Configure and optimize workstations for multimedia.
Learn how to deploy custom multimedia environment settings, such as system sounds and browser multimedia support. Learn technical details about audio and video hardware, such as DVD drives and the Accelerated Graphics Port (AGP).

See “Optimizing Workstations for Multimedia” in this chapter.
Create and use multimedia.
Learn about different file formats and compression, as well as how to play CDs, DVDs, or multimedia on the Web.

See “Using Multimedia Effectively” in this chapter.
Troubleshoot problems with multimedia.
Use this section to learn how to use Troubleshooters and the Sounds and Multimedia option in Control Panel to correct problems with multimedia applications and files.

See “Troubleshooting Multimedia” in this chapter.
What's New
The latest in multimedia and graphics improvements in Windows 2000 Professional include the following:
Accelerated Graphics Port   An Accelerated Graphics Port (AGP) is a new type of expansion slot solely for video cards. Designed by Intel and supported by Windows 2000, AGP is a dedicated bus that provides fast, high-quality video and graphics performance.
Digital Video Disc   Digital Video Discs (DVDs) provide digital, optical disc storage for audio, video, and data. A single DVD can store more than two hours of high-quality audio and video, or up to 4.7 gigabytes (GB) of data. Windows 2000 supports the DVD-Video, DVD-ROM, and DVD-RAM formats for reading and writing to DVD (writing requires third-party software). Windows 2000 supports Universal Disk Format (UDF) version 1.5.
DirectX 7.0   Windows 2000 supports Microsoft® DirectX® version 7.0, which delivers improved multimedia performance, enhanced graphics and sound, and greater ease of use over previous releases. DirectX 7.0 also offers language support for the Microsoft® Visual Basic® development system.
Human Interface Devices   Windows 2000 supports the Human Interface Device (HID) firmware specification, a new standard for input and output devices such as drawing tablets, keyboards, universal serial bus (USB) speakers, and other devices designed to improve accessibility.
IEEE 1394   The Institute of Electrical and Electronics Engineers (IEEE) has developed a standard for ports that lets you connect high-speed digital devices, such as digital video cameras. An IEEE 1394 port, often referred to as a “FireWire,” provides transmission speeds of approximately 98 megabits per second (Mbps) - 393 Mbps, whereas USB provides transmission speeds of approximately 1.5 Mbps - 12 Mbps.
Multiple Monitors   Windows 2000 lets you connect up to 10 monitors to a single computer to create an extended desktop. You can display a single document or application across multiple monitors, or use each monitor to display a different document or application. For example, you can edit an HTML page on one monitor while viewing the rendered Web page on another, or stretch a Microsoft® Excel spreadsheet across several monitors to view all of the columns or rows without scrolling.
OpenGL 1.2   Windows 2000 supports the latest version of Open Graphics Library (OpenGL), providing improved performance, higher visual 3-D quality, and improved capabilities for graphics applications and development.
Universal Serial Bus   Windows 2000 supports the universal serial bus (USB) to connect to a variety of auxiliary input devices, such as drawing tablets, pointing devices, speakers, and digital video cameras.
Windows Media Player   Microsoft® Windows Media™ Player plays both stored and streaming multimedia content from a variety of formats, including Advanced Streaming Format (ASF), Windows Media Audio, MP3, and audio-video interleaved (.avi) and waveform-audio (.wav) files.
Optimizing Workstations for Multimedia
In Windows 2000, network administrators can configure workstations to optimize the multimedia experience and use group and local policies to deploy custom desktop settings or profiles.
This section also presents configuration information and technical details about AGP and DVD device support in Windows 2000 Professional.
Configuring Sounds
You can assign sounds to system and program events, such as when Windows 2000 starts or when a user logs off. You can save different combinations of event and sound pairings as custom sound schemes. You can also specify the default devices to use for playing or recording sound.
Configuring Sound Events and Sound Schemes
Use the following procedures to configure event/sound pairings and save them as custom sound schemes.
For more information about recording sounds to use for sound events or in your custom sound schemes, see “Using Multimedia Effectively” later in this chapter.
For more information about configuring multimedia hardware devices and options, see “Configuring Multimedia Devices” later in this section.
To assign sounds to system and program events
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Sounds tab, and then in the Sound Events box, click the system or program event to which you want to assign a sound.
 3.
In the Name box, click the sound that you want to play when the selected event occurs.

If the sounds that you want to play aren’t listed, click Browse to locate the sound files on your computer or network, or select a different sound scheme from the Scheme box.
You can save an entire set of sound and event pairings as a custom sound scheme.
To create a sound scheme
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Sounds tab, and then in the Sound Events box, click the first system or program event to which you want to assign a sound.
 3.
In the Name box, click the sound that you want to play when the selected event occurs.

If the sounds that you want to play aren’t listed, click Browse to locate the sound files on your computer or network, or select a different sound scheme in the Scheme box.
 4.
Repeat steps 2 and 3 until you have completed assigning event and sound pairings. Click Save As, and then type a name for the new sound scheme.
Configuring Preferred Playback and Recording Devices
If a workstation has multiple audio playback and recording devices, you can specify the preferred devices to use when playing or recording sound. You can also specify the default playback or recording volume for that device.
For more information about configuring a preferred device for Musical Instrument Digital Interface (MIDI) music playback, see “Playing Multimedia” later in this chapter.
To configure a preferred sound playback or recording device
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Audio tab, and then under Sound Playback or Sound Recording, click the preferred device that this workstation should use for playing (or recording) sound.

To specify the default playback or recording level for the selected device, click Volume, and then set the volume controls.

To specify advanced properties such as the hardware acceleration level, click Advanced, click the Performance tab, and then set the properties.
Configuring Audio Performance Options
Windows 2000 lets you optimize audio playback and recording by specifying the default hardware acceleration and sample rate conversion quality.
To configure audio performance options
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Audio tab, and then under Sound Playback or Sound Recording, click Advanced.
 3.
Click the Performance tab, and then under Audio playback or Audio recording, select the hardware acceleration and sample rate conversion quality settings for the workstation.
For more information about hardware acceleration, sample rate conversion quality, and other advanced audio playback and recording options, see Windows 2000 Professional Help.
Configuring the Browser
By default, Microsoft® Internet Explorer plays sounds, animations, and videos from intranet or Internet sites. However, you can disable any of these options to ensure that pages load faster or to enhance a quiet work environment. You can also configure Internet Explorer to play a specific radio station by default every time the browser starts.
To enable or disable sounds, videos, and animation from Web pages
 1.
On the desktop, right-click Internet Explorer, and then click Properties.
 2.
Click the Advanced tab, and then in the Multimedia section, select or clear the Play animations, Play sounds, or Play videos check boxes.
To set a default radio station to play every time Internet Explorer starts
 1.
Start Internet Explorer, and then on the Tools menu, click Options.
 2.
Click the Advanced tab.
 3.
In the Multimedia section, select the Always show Internet Explorer (5.0 or later) Radio toolbar check box, and then click OK.
 4.
On the View menu, point to Toolbars, and then select Radio.
 5.
On the Radio toolbar, click Radio Stations, click Radio Station Guide, and then select the radio station that you want to play.
Configuring Multimedia Devices
Windows 2000 supports the latest multimedia hardware, such as the Accelerated Graphics Port (AGP), DVD devices, and digital video cameras. Windows 2000 also supports a wide range of Human Interface Devices (HIDs) and other peripherals connected through the universal serial bus (USB) or an IEEE 1394 port.
For information about HIDs, IEEE 1394, multiple monitors, or USB, see “Hardware Support” in this book.
Getting Information About Multimedia Devices or Drivers
New to Windows 2000, you can view a list of installed multimedia devices, determine driver versions, perform diagnostics and more, all from one common place: the Hardware tab of the Sounds and Multimedia Control Panel option. The Devices list shows the audio, video, and multimedia devices installed on the workstation. When you click a device in the Devices list, information about that device (such as the manufacturer and operational status) is displayed under Device Properties.
To configure and test specific multimedia devices
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Hardware tab, and then under Devices, select a device.

To determine the properties of the device, such as the driver versions in use, click Properties.

To troubleshoot that device, click Troubleshoot.
Overview of the Accelerated Graphics Port
An AGP is a dedicated bus that delivers improved video and graphics performance over Peripheral Component Interconnect (PCI) buses.
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Figure 11.1   Accelerated Graphics Port Architecture
AGP has the following advantages over PCI video adapters:

The peak bandwidth of AGP is up to four times higher than it is for PCI. AGP has higher sustained rates due to sideband addressing and split transactions.

AGP is a dedicated bus, which reduces contention with other devices.

AGP allows the CPU to write directly to shared system memory, which is much faster than writing directly to local memory.

AGP can read textures from shared system memory while reading and writing other data from local memory, thereby improving performance of high-resolution 3-D scenes.

AGP can run graphics data directly from system memory, instead of having to first move graphics data into video memory before running it.
To use an AGP video adapter, a computer must have an AGP graphics controller and a compatible chipset, such as the Pentium II LX or higher.
Overview of DVD Devices and Options
DVDs can read multiple, digitally stored data streams concurrently for playback of multimedia applications and full-length motion pictures.
Capacity of DVDs
The current capacity of a DVD starts at 4.7 gigabytes (GB). Both sides of the media can be readable and data can be layered on each side (for example, a gold layer of data can be placed above a silver layer). Lower laser power is used to read the top layer, and increased laser power allows the bottom layer to be read. Combining these two options increases the total possible capacity of a single DVD to 17 GB.
Uses of DVD Drives
A DVD drive has many uses. Although it was designed to display full-motion video, its massive storage capacity allows it to perform in other ways, including the following:

DVD discs and devices provide cost-effective storage for large data files. In the future, DVD will allow for writable devices, opening a larger range of options.

Because computers can achieve greater image quality than can conventional broadcast television sets, a DVD on a computer running Windows 2000 achieves even better quality than on standard DVD video player devices.
Windows 2000 supports the following DVD formats:
DVD-Video   A disc containing full-length motion pictures for playback on a computer’s DVD-ROM drive, or on a home DVD-video player.
DVD-ROM   A disc containing a computer application or data that can be read by a DVD-ROM drive. A double-sided, double-layered DVD-ROM can hold up to 17 GB.
DVD-WO   A disc that supports one-time recording, similar to compact disc-recordable (CD-R). DVD-WO requires third-party software.
DVD-RAM   A disc that supports multiple recording capabilities, similar to magneto optical (MO) discs. DVD-RAM requires third-party software.
Hardware Requirements
DVD-video requires a DVD drive and a decoder (a hardware decoder card, a software decoder, or a combination of the two). DVD drives can also read data or play audio from standard CDs.
Full-motion video is stored on DVD in the Moving Pictures Experts Group (MPEG)-2 format. Because high rates of transfer are necessary to read and display full-screen, real-time data, your DVD system must have a decoder.
The following decoder cards and DVD drives are directly supported in Windows 2000:

Toshiba Tecra 760, 780, 8000 or Portege 7010 or 7020, Toshiba Infinia

Quadrant (Cinemaster) 1.2 and 3.0 (but not 2.0), Dell XPS series
A DVD-ready system must also include a video card capable of at least 800 x 600 x 16 bits per pixel (BPP) graphics display with Video Port Extensions (VPEs).
For more information about installing and configuring DVD devices, see Windows 2000 Professional Help.
Software Requirements
DVD technology includes several software components: MPEG-2, AC-3 (audio streaming), subpicture, two class drivers (a ROM class driver and Windows Driver Model [WDM]), UDF file system, Microsoft® DirectShow®, Microsoft® DirectDraw®, and a copyright-protection encryption key.
Figure 11.2 illustrates the Windows 2000 architecture for DVD support.
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Figure 11.2   DVD Architecture
MPEG-2   MPEG-2 is a type of video compression that saves space by saving only the data that changes on the screen. Rather than storing a 640 x 480 x 12 (12-bit color depth) for each frame, only pixels that change are encoded.
Dolby Digital (AC-3)   AC-3 is a type of audio stream developed by Dolby Labs. It allows up to five separate audio channels (left and right front, left and right rear, and center) and a subwoofer channel.
Subpicture   DVDs contain a third data stream called Subpicture. The Subpicture stream delivers the subtitles and any other add-on data, such as system help or director’s comments, which can be displayed while playing multimedia.
DVD-ROM Class Driver   Windows 2000 provides a DVD-ROM driver, which supports the DVD-ROM industry-defined command set known as the Mt. Fuji specification, including commands for copyright protection.
UDF File system   The file system on DVDs is the Universal Disk Format (UDF), which is a standard defined by the Optical Storage Technology Association (OSTA). UDF is compliant with the International Organization for Standardization (ISO)-13346 specification and is intended to succeed the CD-ROM File System (CDFS).
UDF supports long and Unicode file names; access control lists (ACLs); streams; reading and writing (not just mastering); and the ability to start up the computer. Windows 2000 supports UDF version 1.5, and future versions (including the UDF 2.0 draft recently approved by the OSTA) as they are released.
DirectShow   DirectShow provides support for a DVD Navigator and Splitter, proxy filters for video and audio streams, a video mixer, a video renderer, and an audio renderer. DVD movies have the equivalent of channels for the various data streams necessary to play a full-length movie. Data streams consist of not only the MPEG portion, but also digital audio, which can have Dolby surround sound and closed-captioning information. For a single video image, a DVD can provide up to eight languages and sound tracks and 32 subtitle tracks, and can support up to nine angles and eight ratings. DirectShow provides support for tracking these data streams and passing them to the proper codec.
DirectDraw HAL With VPE   Decoded video can become quite large. An MPEG-2 stream starts out at a rate of about 5–10 megabits per second (Mbps). After the stream is decoded, it can easily exceed 100 Mbps. Processing this amount of information in a continuous stream can overwhelm the PCI bus. So most of the decoding of the information is moved back to the hardware level by using dedicated MPEG decoder cards.
Support for these decoder cards is built in to DirectX, with DirectDraw’s support for Video Port Extensions (VPEs). Video Port Extensions allow the MPEG stream to be written directly to the frame buffer memory of the video card from the MPEG decoder card. Data transfer occurs through a special cable that connects the video card and the decoder card at the hardware level. DirectDraw allows the data stream to be moved through the hardware layer while keeping track of such things as synchronization.
Copyright Protection   Copyright protection for DVD is provided by encrypting key sectors on a disc, and then decrypting those sectors before decoding them. Microsoft provides support for both software and hardware decrypters by using a software module that enables authentication between the decoders and the DVD-ROM drives in a computer.
As part of the copyright protection scheme used for DVD, the DVD Consortium has set up eight worldwide regions, as shown in Table 11.1.
Table 11.1   DVD Regional Codes
Code
Country/Region
1
Canada, USA, United States Territories
2
Japan, Europe, South Africa, Middle East (including Egypt)
3
Southeast Asia, East Asia (including Hong Kong SAR)
4
Australia, New Zealand, Pacific Islands, Central America, Mexico, South America, Caribbean
5
Former Soviet Union, Indian Subcontinent, North Korea, Mongolia, Africa
6
China
7
(Reserved, currently unused)
8
Special international venues (including in-flight airlines, cruise ships, and so on)
Discs are playable on DVD devices in some or all of the regions according to regional codes set by the creators of the content. Microsoft provides software that responds to the regionalization codes as required by the DVD Consortium and as part of the decryption licenses.
For more information about configuring DVD devices, see Windows 2000 Professional Help.
Configuring Video Camera Devices and Options
Windows 2000 Professional supports the latest digital video cameras and other input devices attached through high-speed USB or IEEE 1394 ports.
For more information about installing and configuring digital video cameras, see “Scanners and Cameras” in this book.
Using Multimedia Effectively
Windows 2000 opens new possibilities for creating audio, video, and multimedia content and for using it more effectively on your intranet.
For more information about configuring audio, video, and multimedia devices and workstation defaults (such as audio playback level), see “Optimizing Workstations for Multimedia” earlier in this chapter.
Playing Multimedia
Windows 2000 supports a wide range of playback devices and multimedia sources, technologies, and file types. For example, you can play audio from a MIDI device, or play radio from a radio station that is broadcasting over the Web. You can play video or multimedia on DVD using DVD Player, or watch a streaming broadcast over the Web using Windows Media Player.
For more information about setting preferred devices for playing audio, see “Configuring Sounds” earlier in this chapter.
Playing CDs
You can play audio compact discs (CDs) on a CD-ROM drive or a DVD drive. (Standard CD-ROM drives cannot read DVD discs.) When you insert an audio CD into a CD drive, Windows 2000 Professional starts CD Player, as shown in Figure 11.3.
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Figure 11.3   Windows 2000 CD Player
CD Player can automatically read play lists and album information when you insert a new CD. For more information about using CD Player or playing audio CDs, see Windows 2000 Professional Help.
As multimedia information is read from a CD-ROM drive, the multimedia subsystem determines what the data stream contains and then separates and routes the data accordingly.
To provide the best possible performance from CD-ROM drives, Windows 2000 includes the 32-bit CDFS for reading files from CD-ROM drives quickly and efficiently.
You can set the default volume for playing CDs or enable digital audio playback by using the following procedure.
To set CD playback options
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Hardware tab. Under Devices, select the CD device, and then click Properties.
 3.
Set the volume and digital playback properties:

Under CD Player Volume, set the default volume for playing audio on CD.

Under Digital CD Playback, select the Enable digital CD audio for this CD-ROM device check box to send the playback from the CD Player to a digital device, such as USB speakers. Selecting this check box disables audio output from the headphone jack on the CD-ROM drive.
Playing Audio from MIDI Devices
Musical Instrument Digital Interface (MIDI) is a serial interface standard that allows for the connection of music synthesizers, musical instruments, and computers. The MIDI standard is based partly on hardware and partly on a description of the way in which music and sounds are encoded and communicated between MIDI devices.
MIDI is used as a development tool for musicians. Virtually all advanced music equipment supports MIDI, and MIDI offers a convenient way to precisely control the equipment.
Windows 2000 supports the General MIDI Specification to request particular instruments and sounds. This specification is an industry standard that defines how MIDI should be used, and it is supported by Microsoft and most MIDI sound-card manufacturers.
MIDI devices supported by Windows 2000 include the following:

FM Synthesis

Hardware Wavetable Synthesis

Software Wavetable Synthesis

MPU401
You can also download standard MIDI files from the Web and play them by using Windows Media Player.
To configure a preferred MIDI music playback device
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Audio tab, and then under MIDI Music Playback, click the preferred device that this workstation should use for playing MIDI music.

To specify the default playback or recording level for the selected device, click Volume, and then set the volume controls.

To display information about the selected device, click About.
For more information about installing and configuring MIDI devices, see Windows 2000 Professional Help.
For more information about MIDI devices and the MIDI standard, see the Microsoft Knowledge Base link on the Web Resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.
Playing DVDs
Windows 2000 DVD Player lets you play multimedia content and provides instant access to advanced DVD features, including movie chapters, optional closed-caption support, and choice of playback formats.
DVD Player is shown in Figure 11.4. It contains, from left to right, buttons for choosing a channel; VCR buttons for controlling playback; and menu navigation buttons for using the on-screen menu choices.
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Figure 11.4   Windows 2000 DVD Player
DVD Player has only basic functionality and can be replaced by a third-party application. You can install or uninstall DVD Player from Control Panel by using the Add/Remove Programs option.
Note   When DVD Player is started, it searches all local drives in alphabetical order, starting with C, for a folder called Video_TS. When this folder is located, the data file in it is loaded and video streaming begins. If this folder exists on a drive that comes before the preferred DVD drive, DVD Player tries to play the data in the first folder it finds.
For technical information about DVD devices and options, see “Configuring Multimedia Devices” earlier in this chapter.
Playing Multimedia From Files or the Web
You can play audio, video, or multimedia from files or from the World Wide Web as follows:

Click a hyperlink to a source of streaming audio, video, or multimedia, such as Advanced Streaming Format (.ASF). Windows Media Player contacts the server and begins streaming the multimedia to play in real time. Because the multimedia is streamed rather than downloaded, no files are stored in your temporary Internet cache, conserving hard drive space.

Download a nonstreaming audio, video, or multimedia file in a compatible format, such as MIDI, MP3, or .wav, and then play the file locally by using Windows Media Player.

Use the Internet Explorer Radio toolbar to tune to a radio station that is broadcasting over the Internet.
To play a radio station over the Web or an intranet
 1.
Start Internet Explorer On the View menu, point to Toolbars, and then click Radio.
 2.
On the Radio toolbar, click Radio Stations, and then select the radio station that you want to play.
If Windows Media Player is registered as the default media player, it automatically plays the streaming and nonstreaming file types shown in Table 11.2. When you open a file that has one of these extensions, either by double-clicking a file icon or clicking a link in a Web page, Windows Media Player starts.
Table 11.2   File Formats Supported by Windows Media Player
File Type
File Name Extensions
Microsoft Windows Media formats
asf, .asx, .wma, .wax
MPEG
.mpg, .mpeg, .m1v, .mp2, .mp3, .mpa, .mpe
MIDI
.mid
Apple QuickTime 1 & 2, Macintosh AIFF Resource
qt, .aif, .aifc, .aiff, .mov
UNIX formats
.au, .snd
Other formats
.avi, .wav
Windows Media Player works with the server to negotiate the most efficient allocation of bandwidth and deliver high-quality streaming media. The higher the bandwidth of your Internet connection, the higher the quality of the streaming multimedia. The best results are achieved by using high-speed connections, such as a T1 connection, or through a cable modem or digital subscriber line (DSL) line.
For more information on playing multimedia files using Windows Media Player, see the Microsoft Knowledge Base link on the Web Resources page at http://windows.microsoft.com/windows2000/reskit/webresources.
Creating Multimedia
Windows 2000 lets you record audio from a variety of input devices, and then save audio files in a variety of different formats, by using Windows Sound Recorder.
Recording Audio
If you have a microphone or other input device connected to your computer, you can record sound by using Sound Recorder as shown in Figure 11.5.
[image: image5.png]Postor: - Length
Ji
| I | |





Figure 11.5   Windows 2000 Sound Recorder
Sound Recorder lets you add effects, such as echo; increase or decrease the speed or volume; and insert or mix other audio files. You can save audio files in one of three standard formats — CD quality, radio quality, or telephone quality — or you can choose a custom format to maximize compression or utilize a specific audio format (such as .au).
To select an audio format
 1.
On the Start menu, point to Programs, point to Accessories, point to Entertainment, and then click Sound Recorder.
 2.
On the File menu, click Properties.
 3.
In the Choose from box, click Recording formats, and then click Convert Now.
 4.
In the Format box, click the format that you want, and then in the Attributes box, click the attributes (such as the sampling frequency or number of channels) available for the selected format.
For more information about audio formats and compression, see Windows Sound Recorder Help.
Mixing and Editing Audio
You can insert and combine audio files using Sound Recorder, as described in the previous section. You can mix audio input from different devices using the Windows 2000 Volume Control tool, as shown in Figure 11.6.
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Figure 11.6   Windows 2000 Volume Control
The Volume Control tool lets you manage the different audio lines installed on a computer. An audio line consists of one or more channels of waveform-audio data coming from one origin or system resource. For example, a stereo audio line has two data channels, yet it is considered a single audio line. A mixer control can take on many different characteristics (such as controlling volume), depending on the characteristics of the associated audio line.
The number of lines that you can mix by using Volume Control depends on the number of audio source lines that the computer has, and whether they are using Volume Control for input or output.
Creating Dynamic Web Pages
You don’t need multimedia authoring software to create multimedia presentations that can be broadcast over your intranet on a server computer running Windows 2000 Server. You can use HTML+Time and Extensible Markup Language (XML) multimedia elements to create interactive, multimedia Web pages.
For more information about using HTML+Time and XML to create dynamic Web pages that incorporate multimedia, see the Knowledge Base link on the Web Resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.
Using HTML+Time
You can use HTML+Time to add dynamic, interactive content to your Web pages. For example, you can create slide-show-style or multimedia presentations with synchronized text, images, audio, video, and streaming media. These presentations can be timed, interactive, or a combination of both.
HTML+Time provides an architecture that lets you extend and introduce new representations to the XML multimedia space, while taking advantage of the timing and synchronization attributes specified through HTML+Time. Custom representations can express data visualization concepts, three-dimensional models, interactive media animations, and audio and visual content.
To use HTML+Time, add HTML+Time attributes to existing HTML elements on a page. HTML+Time attributes let you specify when an element appears on a page, how long it remains displayed, and how the surrounding elements are affected.
The implementation of HTML+Time relies on Microsoft® DirectAnimation®, which enables time-varying, media-rich content and animations to be expressed in self-contained objects. These objects encapsulate both media and the behaviors that change properties of the media over time. For every HTML element associated with a timeline, you can access DirectAnimation behaviors by using scriptable properties.
Note   HTML+Time features are available as of Internet Explorer 5 and are not supported by earlier versions of the browser.
Creating Custom XML Multimedia Elements
You can also use persistent XML elements and attributes to add timing to your pages. HTML+Time supports a complete object model that extends the existing Dynamic HTML (DHTML) Document Object Model (DOM), allowing you to use properties, methods, and events to add interactivity to pages.
Custom XML multimedia elements make it easy to add multimedia to pages without having to write complex scripts. You can write one script implementing the new element and reuse it as necessary. You can further customize an element by creating properties, methods, and events associated with it.
Overview of DirectX 7.0
Windows 2000 supports DirectX version 7.0, which provides software with quick, transparent access to a broad range of peripherals, including graphics cards, audio adapters, and input devices, and delivers improved performance and enhanced graphics and sound over previous releases of DirectX.
DirectX 7.0 offers language support for the Microsoft® Visual Basic® development system. Improvements include improved 3-D graphics and sound, faster performance, easier development of 3-D sound algorithms, and easier creation of complex musical soundtracks.
DirectX provides a common set of instructions and components that accomplishes two things:

Lets multimedia applications run on any Windows-based computer, regardless of the hardware, and ensures that products take full advantage of high-performance hardware capabilities to achieve the best possible performance.

Provides tools to developers that simplify the creation and playback of multimedia content, while making it easier to integrate a wide range of multimedia elements.
Table 11.3 provides an overview of DirectX technologies.
Table 11.3   Overview of DirectX Technologies
DirectX Technology
Description
DirectDraw
Manipulates display modes, displays memory, and provides hardware overlay support and flipping surface support.
Microsoft® Direct3D® Immediate Mode
Enables a drawing interface for 3-D video display hardware.
Microsoft® DirectInput®
Enables support for input devices, such as joysticks, and input-output devices, such as force-feedback controllers.
Microsoft® DirectSound®
Captures, mixes and plays multiple audio signals, manages hardware voices, and enables 3-D sound effects in applications.
Microsoft® DirectPlay®
Connects games for multi-user play over the Internet, a modem link, or an intranet.
Microsoft® DirectMusic®
Creates interactive, variable music soundtracks that are streamed to DirectSound.
Microsoft® DirectShow®
Enables capture and playback of multimedia streams with Windows Media Player.
DirectX Diagnostic Tool
Windows 2000 includes the DirectX Diagnostic Tool, a utility for diagnosing problems with DirectX drivers and multimedia hardware. You can use the tool to obtain detailed system and driver information, as well as to test specific devices. The results can be reported to Microsoft Product Support Services to speed up diagnosing and resolving problems. To display the DirectX Diagnostic Tool, as shown in Figure 11.7, on the Start menu, click Run, and then type:
dxdiag
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Figure 11.7   DirectX Diagnostic Tool
For more information about using the DirectX Diagnostic Tool, see the tool’s Help.
DirectX Software Development Kit
The Microsoft® DirectX® 7.0 Software Development Kit (SDK) contains information for developers, including code samples, diagnostic tools, and sample applications. You can order the SDK on CD-ROM or download it from the DirectX Web site.
For more information about DirectX, or about downloading or ordering the DirectX SDK, see the Knowledge Base link on the Web Resources page at http://windows.microsoft.com/windows2000/reskit/webresources.
Troubleshooting Multimedia
Windows 2000 Professional Help includes intuitive, step-by-step Troubleshooters to help you diagnose problems with audio, video, or multimedia, including:

Multimedia and Games Troubleshooter

DirectX Troubleshooter

Hardware Troubleshooter

Display Troubleshooter

Sound Troubleshooter
In Windows 2000 you can also troubleshoot multimedia devices using the following procedure.
To troubleshoot specific multimedia devices
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Hardware tab, and then under Devices, select the device that you want to troubleshoot.

To determine the properties of the device, such as the driver version in use, click Properties.

To troubleshoot the device, click Troubleshoot.
Windows Media Player Help also contains a number of troubleshooting scenarios that can assist you in diagnosing and solving problems with playing audio, video, or multimedia.
Windows 2000 also includes the DirectX Diagnostic Tool, which you can use to obtain detailed system and driver information, as well as to test specific devices. The results can be reported to Microsoft Product Support Services to speed up diagnosing and resolving problems. To launch the DirectX Diagnostic Tool, on the Start menu, click Run, and then type:
dxdiag
Correcting Problems With Playing WAV Files
When a multimedia application is unable to play waveform-audio (WAV) files, it is usually caused by one or more of the following problems:
The Sound Card is Not Installed Properly
Make sure that the sound card settings do not conflict with other hardware. Use the Add New Hardware icon in Control Panel to detect your hardware and determine if you have any hardware for which the appropriate driver is not yet installed. Verify port and interrupt request (IRQ) settings.
Note   If the sound card can play MIDI files, the card is probably properly installed.
The Volume Is Muted or Too Low
Check to see that the volume in Volume Control is not muted or set too low.
To check the volume

On the Windows 2000 task bar, right-click the Volume Control icon, and then on the shortcut menu click Open Volume Controls. Verify that the Mute check box for Wave Balance is not selected, or raise the volume slider for Wave Balance if it is too low.

Note   If the Volume Control icon is not on the task bar, click Start and point to Programs, Accessories, and Entertainment, and then click Volume Control.
A Waveform-Audio Driver or Audio Codec Is Not Installed
If you are running Sound Recorder and there is no waveform-audio driver or audio codec installed, you receive an error message. In this case, make sure that the waveform-audio driver or audio codec is listed; to verify this, in Control Panel, double-click Sounds and Multimedia click the Hardware tab, and then examine the Devices list. Check with the manufacturer of the sound card to ensure you have the proper drivers. If you cannot find the correct audio codec or driver for the sound card in the list, connect to the manufacturer’s Web site and download a current driver.
Correcting Problems With Playing MIDI Files
If a multimedia application cannot play MIDI files, it is generally the result of one or more of the following problems:
The Sound Card Is Not Installed Properly
Make sure that the sound card settings do not conflict with other hardware. Use the Add New Hardware option in Control Panel to detect your hardware, and determine whether you have any hardware for which the appropriate driver is not yet installed. Verify port and IRQ settings.
Note   If the sound card can play WAV files, the card is probably properly installed.
The Volume Is Muted or Too Low
See “Correcting Problems With Playing WAV Files” earlier in this chapter.
A MIDI Driver Is Not Installed
If you are using Media Player and cannot play a MIDI file, there might be no MIDI driver installed. Try installing the driver that was provided with the hardware.
The Incorrect MIDI Output Device Is Selected
If the selected MIDI device is incorrect, you hear no MIDI output. Choose only External MIDI or MIDI OUT for an add-on MIDI card, or if an external MIDI device (for example, a synthesizer) is connected to the MIDI port of a sound card. For example, if you do not have an MPU-401 compatible synthesizer plugged into the MIDI port, make sure that MPU-401 is not selected as your default MIDI device.
To select a preferred MIDI output device
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Audio tab.
 3.
Under MIDI Music Playback, in the Preferred device box, click the instrument that you want to use for MIDI music playback.
Correcting Problems With Playing a DVD Disc
Because DVD uses several pieces, the first step in troubleshooting a DVD issue is to determine which piece is not functioning correctly.

Make sure that the DVD drive is displayed as functioning correctly in Device Manager.

Make sure that Windows 2000 can read the data on the DVD by using Windows Explorer to see the contents of the DVD. There can be at least two folders: Video_TS and Audio_TS.

If you are using a hardware decoder with your DVD drive, use Device Manager to verify that the decoder is working properly. To verify that your hardware decoder is supported by Windows 2000, check the Microsoft Windows Hardware Compatibility List link on the Web resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.

If you are using a software decoder with your DVD drive, use Device Manager to verify that the software decoder is working properly.
For additional help in troubleshooting problems playing DVDs, click the Help menu in DVD Player.
Correcting Problems With Playing an Audio CD
If a you are unable to hear an audio CD being played, it is commonly caused by one or more of the following problems:
The CD-ROM Drive Is Not Properly Installed
Place a data CD in the CD-ROM drive, and make that sure you can view the files in Windows Explorer or list the files at the command prompt. If you can, the CD-ROM drive is properly installed. If not, verify your disk drivers — Enhanced Small Device Interface (ESDI), small computer system interface (SCSI), Proprietary, MSCDEX — and then make the appropriate configuration changes so that you can view the files on a data CD.
The Volume Is Muted or Too Low
See “Correcting Problems With Playing WAV Files” earlier in this chapter.
Digital CD Audio for the CD-ROM Device Is Not Enabled
You can have Windows 2000 use digital playback of a CD audio for digital devices, such as USB speakers. This feature works only with certain CD-ROM devices. If you enable digital CD audio and encounter playback problems, such as audio skipping, or cutting in or out, your CD-ROM drive might not be compatible with digital CD audio.
To verify that the digital CD audio is enabled
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Hardware tab. Under Devices, select the CD device, and then click Properties.
 3.
Under Digital CD Playback, select the Enable digital CD audio for this CD-ROM device check box to send the playback for the CD Player to a digital device, such as USB speakers. Selecting this check box disables audio output from the headphone jack on the CD-ROM drive.
The CD-ROM Is Not Connected to the Sound Card
If the CD-ROM is playing and there is no sound coming from the sound card speakers, try plugging the speakers or headphones into the audio jack on the face of the CD-ROM drive. If you hear sound, check the internal or external audio connection between the CD-ROM drive and the sound card.
Correcting Headphone Problems
If headphones are connected directly to a sound card, verify that the headphones are plugged into the line-out or audio-out connectors and not, for example, to the line-in or microphone-in connectors.
If the headphones are connected correctly and you still cannot hear audio, verify that the sound card is correctly installed by reviewing its properties.
To view sound card properties
 1.
In Control Panel, double-click Sounds and Multimedia.
 2.
Click the Hardware tab. Under Devices, select your sound card or CD-ROM drive, and then click Properties.
 3.
Adjust the volume settings until you can hear output from the headphones.
Note   If you have Digital CD Playback enabled for a CD-ROM drive, audio output from the headphone jack on the CD-ROM drive is disabled.
Additional Resources

For more information about MIDI devices and the MIDI standard, see the Knowledge Base link on the Web Resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.

For more information about playing multimedia files using Windows Media Player, see the Knowledge Base link on the Web Resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.

For more information about using HTML+Time and XML to create dynamic Web pages that incorporate multimedia, see the Knowledge Base link on the Web Resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.

For more information about DirectX, or on downloading or ordering the DirectX SDK, see the Knowledge Base link on the Web Resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.

For more information about DVD drives and hardware decoders supported by Windows 2000, see the Knowledge Base link on the Web Resources page at: http://windows.microsoft.com/windows2000/reskit/webresources.
